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1. Affordable, easy-to-use, accurate and precise 
 

  
Multimeter view Oscilloscope view 

 

Applications include: 

• Microprocessor and microcontroller power profiling and optimization 

• Hardware power optimization 

• Microcontroller and device sleep current optimization 

• Hardware and software troubleshooting 

• Software characterization and interrupt service routine profiling 

• USB inrush and suspend current pre-compliance testing  

• General-purpose current, voltage, power, charge, and energy measurement 

 

The Joulescope™ JS220 is the most affordable and easy-to-use precision DC energy analyzer.  It 

measures current and voltage, then computes power and energy.  Many modern battery-powered 

devices and IoT devices have a high dynamic current range, which makes accurate measurement 

difficult.  When “sleeping” the devices consume nanoamps (nA) or microamps (µA), but when active, 

they consume milliamps (mA) or amps (A).  Joulescope combines high-speed sampling and rapid 

dynamic current range switching to provide accurate and seamless current and energy measurements, 

even for devices with rapidly varying current consumption.  The unprecedented accuracy and low-cost 

of Joulescope allows every engineer on the team to measure the energy consumed by the target device 

during development.  Joulescope provides rapid feedback on how changes affect the overall product 

battery life.   

Joulescope displays instantaneous voltage, current, power, and energy, like a multimeter.  The 

multimeter provides a quick and easy summary of the present state of your device. 

Joulescope displays waveforms of voltage and current over time, like an oscilloscope.  This oscilloscope 

view allows you to identify and to troubleshoot dynamic behavior and short events, including inrush 

current, event handlers, and tasks.   
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2. Key benefits 
 

• Dynamic range: The Joulescope JS220 accurately measures electrical current over ten orders of 

magnitude from amps down to nanoamps. This wide range allows accurate and precise current 

measurements for modern devices.  Sleep modes are often just nanoamps (nA) or microamps 

(µA).  Active modes are often milliamps (mA) or amps (A). 

• Low voltage drop: Most multimeters and current meters have a significant voltage drop 

(sometimes called burden voltage or insertion loss), which affects the actual voltage delivered to 

the device under test.  Joulescope has a total voltage drop of 25 mV at 1 A, which keeps your 

target device running correctly. Joulescope’s extremely fast current range switching maintains 

low voltage drop even under rapidly varying current demands. 

• Makes the invisible visible:  The JS220 measures current and voltage 2 million times per second 

with 300 kHz bandwidth.  This high sampling rate makes the power consumption of interrupt 

service routines, inrush currents, and other short events visible. 

• Easy to use:  The JS220 reports cumulative energy and charge consumption along with real-time 

current, voltage, and power. The multimeter view clearly shows the most recent value, while 

the oscilloscope view allows you to explore changes over time.  Much simpler and more 

accurate than anything in its class! 

• Customizable:  The host software is open source on GitHub.  You can also swap the banana jack 

front panel with front panels that have other connector types.  The front panels are open source 

on GitHub.   

• Portable: The JS220 fits in your backpack and only needs a small part of your desk.  It provides 

precision measurements in a portable, unintrusive form factor. 

• Affordable:  The Joulescope JS220 is affordable and priced so that every developer on the team 

can have one at their desk.  With such convenient access, Joulescopes allow developers to see 

the impact of their changes on energy consumption immediately.  Developers can make 

informed choices to account for battery life during design. Eliminate power consumption 

surprises during final product testing! 
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3. Key features 
 

• ±15V voltage range 

• ±3A current range, continuous 

• ±10A current pulses (<10 ms, < 3A average per second) 

• Down to 0.5 nA resolution, equivalent to 34-bits of dynamic range 

• Synchronously measures voltage and current at 2 million samples per second, 16-bit 

• 300 kHz bandwidth 

• Rapid 1 μs switching between shunt resistors 

• Enwavify™ technology for consistent, accurate measurements through current range changes 

• Computes power, energy, and charge 

• Operates with minimal voltage disturbance between Current + and Current – ports 

• Up to ±48V common-mode voltage between USB ground and sensing ports 

• 4 general-purpose inputs and 2 general-purpose outputs 

• 1 BNC trigger configurable for either input or output 

• Programmable on/off for power cycling the target device and measuring inrush currents 

• USB 2.0 high-speed host connectivity with modern USB C connector 

• Host software support for Microsoft® Windows®, Apple® macOS®, and Linux® 

• Host software user interface provides real-time graphs of current, voltage, and power over time 

• Python library and scripting provided 

• Host software is open source and available on GitHub 

• Swappable front panel with open-source designs on GitHub 

• Firmware upgradable 

See Section 7 for the full specifications. 
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5. Meet Your Joulescope JS220 
The JS220 arrives in a carry case: 

 

Unzip the carry case to find the JS220 instrument and accessories: 
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Your Joulescope JS220 purchase includes: 

• Joulescope JS220 instrument with factory calibration 

• Binding Post Front Panel, already installed 

• 5’ USB 2.0 A to C cable 

• GPIO cable assembly 

• 2 mm Allen wrench, for optionally swapping the front panel 

• Quick Start Guide 

• Joulescope sticker 

• Carry case 

You will need to provide: 

• A host computer running Microsoft® Windows® 11 or 10, Apple® macOS® 12 or 10.15, or Linux®.  

Most computers manufactured within the last five years should work.  The computer requires 

an available USB 2.0 port, at least 500 MB of hard drive / solid state drive storage space, and 1 

GB of available RAM.   

• Suitable cable(s) to connect the Joulescope JS220’s binding posts to your system, often the 

power source and device under test. 

• For computers without USB A ports, a suitable USB cable or USB adapter. 

• Optional BNC cable for connecting trigger to other equipment. 

You need an internet connection to download the free software. 

The front side of the JS220 has the connectors that connect to your system: 

 

Your JS220 measures the voltage across the Voltage + and Voltage – binding posts.  Your JS220 measures 

the current flowing through the Current + to the Current – binding posts.  If you have a power source 

and target device, connect the positive side through the current binding posts.  You can then connect 

the voltage signals across either your power source or your target device.  For more connection 

examples, see Section 9. 

The Sensor Status indicator is off when your JS220 is powered off or inactive.  Flashing red indicates that 

the instrument is ready but the current flow is not yet enabled.  Solid green indicates that current 

measurement is enabled. 
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The backside of Joulescope has the host USB connector, status LED, GPIO connector, and trigger 

connector: 

 

Use the provided USB C to USB A cable to connect the USB host computer connector to your host 

computer.  If your computer only has USB C ports, use an adapter (not provided) or a USB C to USB C 

cable (not provided). 

The Controller Status indicator is off when the JS220 is not connected to the host computer, or the host 

computer has not yet activated the JS220 over USB.  Microsoft Windows computers activate devices 

immediately when connected while macOS and Linux do not active the device until the Joulescope 

software attempts to use the device.  Solid blue indicates that the JS220 is activated.  Solid green 

indicates that the JS220 device is running normally. 

The GPIO connector provides four general-purpose inputs and two general-purpose outputs.  See 

Section 12 for details. 

The BNC Trigger connector provides either a Trigger Out or a Trigger In.  This Trigger allows the JS220 to 

synchronize data collection with other equipment. 
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6. Quick start 
Download the host software from http://www.joulescope.com/download.  Follow the instructions on 

the download page to install the software for your platform.  Windows and macOS hosts just need you 

to install the software.  Linux hosts also typically require that you manually install a udev rule.  See 

section 8.1 for details. 

Start the Joulescope host software. 

 

Connect the Joulescope USB port to the host computer using the provided USB cable.  The host software 

will automatically detect the connected Joulescope and start displaying data. 

 

To measure the current and charge, connect the Joulescope Current port inline between the positive 

output from your power source and your target device under test.  The maximum voltage between any 

port Current +, Current -, Voltage +, and Voltage – should never exceed ±15V.  All sensor ports are 

electrically isolated from USB, but the voltage between any port and USB ground should never exceed 

±48V. 

To also measure voltage, power, and energy, connect the Joulescope Voltage ports across your power 

source’s positive and negative connections.  Alternatively, you can connect the Voltage port across your 

target device’s positive and negative connections. 

The Joulescope JS220 can be used in a variety of measurement configurations.  For more common 

connection scenarios, see Section 9. 

Operate your device under test.  The Joulescope host software starts in the Multimeter view by default.  

Use the Multimeter view to measure the current, voltage, power, charge, and energy consumption.   

http://www.joulescope.com/download
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Dive into more detail with the oscilloscope view.  Select View → Oscilloscope Default to display 

waveforms of voltage, current, and power over time. 
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7. Specifications 

7.1. Absolute maximum ratings 
 Min Max Unit 

USB voltage -0.3 6 V 

Max voltage applied between any port 
   Current +, Current -, Voltage +, Voltage - 

-20 20 V 

Max voltage to USB ground from any port 
   Current +, Current -, Voltage +, Voltage - 

-48 48 V 

Input current (powered, burst) -10 10 A 

Input current (powered, sustained) -3 3 A 

Input current (unpowered) N/A (off) N/A (off) A 

Storage temperature -40 80 °C 

Operating temperature 0 50 °C 

Relative humidity (non-condensing) 0 95 % 

Altitude from sea level -100 2500 m 

Max voltage applied to GPI relative to USB ground -10 10 V 

 

7.2. Mechanical 

7.2.1. Instrument Only 

 Typical Unit 

Weight 190 grams 

Width 99 mm 

Length (including binding posts and BNC connector) 126 mm 

Height 28 mm 

7.2.2. Complete product kit 

 Typical Unit 

Weight 510 grams 

Width 190 mm 

Length 200 mm 

Height 60 mm 
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7.3. Recommended operating conditions 
 Test condition Min Typical Max Unit 

Operating temperature  10  40 °C 

USB supply voltage  4.5 5.0 5.5 V 

USB supply current    500 mA 

Voltage applied across  
   Voltage + and Voltage - 

 -14.5  14.5 V 

Voltage applied across 
   Current + and Current -  

Current range off -15  15 V 

Input current continuous -3  3 A 

Input current pulse < 50 milliseconds,  
< 3A average 

-10*  10* A 

Input current pulse < 250 milliseconds 
< 3A average 

-5*  5* A 

* Suitable for handling inrush currents when connecting capacitive loads. 

7.4. Specification conditions 
Temperature 23 °C ± 10 °C 

Humidity 20% to 80% RH, non-condensing 

Calibration interval 1 year* 

* Recommended to comply with industry-standard practices, but the Joulescope JS220 is designed not 

to need recalibration. 

7.5. Current measurement specifications 
Range Accuracy Resolution Impedance Guaranteed 

10 A* ±0.25% ±1.50 mA 175 µA 0.01 Ω ±9.7 A 

180 mA ±0.25% ±150 µA 15 µA 0.11 Ω ±185 mA 

18 mA ±0.25% ±15 µA 1.5 µA 1.11 Ω ±18.5 mA 

1.8 mA ±0.25% ±1.5 µA 150 nA 11.1 Ω ±1.85 mA 

180 µA ±0.25% ±150 nA 15 nA 111 Ω ±185 µA 

18 µA ±0.25% ±30 nA 1.5 nA 1111 Ω ±18.5 µA 

* Joulescope is designed for 3 A sustained.  See the recommended operating conditions for maximum 

durations for higher currents. 

Test current measurement bandwidth by varying the effective load impedance.  Due to load 

capacitance, altering the source voltage is not a valid method of testing current bandwidth. 

The JS220 is sensitive to RF radiation which induces real current in test setups.  When tested with 

EN61326-1 and 3 V RMS/m, the JS220 measured up to 10 µA (observed, not guaranteed) of current at 

several frequencies.  The exact frequency susceptibility varies with cable length and configuration. 

7.6. Voltage measurement specifications 
Range Accuracy Resolution Guaranteed 

15 V ±0.1% ±10 mV 1.2 mV ±14.5* 

2V ±0.1% ±2 mV 180 µV ±1.98 

* Beta units are limited to ±13.6 V. 
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The JS220 is sensitive to RF radiation which induces real voltages in test setups.  When tested with 

EN61326-1 and 3 V RMS/m, the JS220 error increased by 10 mV (observed, not guaranteed) at several 

frequencies.  The exact frequency susceptibility varies with cable length and configuration. 

7.7. General specifications 
 Test condition Min Typical Max Unit 

Sampling frequency 25 °C  2000000  sps 

Sampling frequency 25 °C -25  25 ppm 

Measurement bandwidth - 3 dB 280 310 350 kHz 

Front panel insertions    100  

 

7.8. Parasitic effects specifications 
 Test condition Min Typical Max Unit 

Current leakage (Voltage + to -) 25 °C, ±3.3V  2  nA 

Current leakage (Voltage + to -) 25 °C, ±5V  2  nA 

Current leakage (Voltage + to -) 25 °C, ±15V  3  nA 

Shunt resistor voltage, max -2 to 2 A, static  20 21 mV 

Burden voltage (Current + to -) 1 A, banana jacks 0 25 35 mV 

Burden voltage (Current + to -) Shunt resistor, < ±2 A   ±20 mV 

Shunt switching time Over-range 
< 200 ns rise time 

0 0.8 1.2 µs 

Measurement gap following a 
current range switch 

   0 µs 

 

7.9. Software-controlled fuse specifications 
 Test condition Min Typical Max Unit 

Current leakage (Current + to -) 25 °C, 3.3V  ±5  nA 

Current leakage (Current + to -) 25 °C, 5V  ±7  nA 

Current leakage (Current + to -) 25 °C, 15V  ±28 ±5000 nA 

 

7.10. General Purpose Inputs & Outputs 
 Test condition Min Typical Max Unit 

Internal 3.3V reference  3.135 3.3 3.465 V 

External reference Vref < (VUSB – 0.5 V) Vref -
0.1 

Vref Vref + 
0.1 

V 

Input leakage per pin 25 °C   ±10 nA 

Input leakage per pin    ±100 nA 

Output voltage high -100 μA Vcco -
0.1 

  V 

Output impedance 10 mA 45 50 80 Ω 

GPI sample rate   2  MSPS 

Continuous output current Per pin   ±50 mA 

Total power dissipation Over output impedance   0.25 W 
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The Joulescope uses the TI SN74LVC2T45 for both the GPIs and GPOs.  See the SN74LVC2T45 datasheet 

for more information.  Both the GPIs and GPOs are protected with the TI TPD4E1U06 for ESD protection. 

 

http://www.ti.com/lit/gpn/sn74lvc2t45
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8. Host software 
The Joulescope host software runs on a host computer and communicates with the Joulescope JS220 

instrument over USB 2.0 high-speed.   

The software works with Microsoft® Windows® 11 and 10, Apple® macOS® 12 and 10.15, and Linux®.  

For Linux, only Ubuntu 22.04 LTS is officially supported.  The Joulescope software only supports 64-bit 

operating systems with 64-bit Python 3.8+.   

8.1. Installation 
The Joulescope software is available to download at  

www.joulescope.com/download/ 

Click on the download link for your platform.  For a list of all releases for all platforms, see 

https://download.joulescope.com/joulescope_install/index.html 

Follow the usual process to download and install the software following the on-screen directions.  

Several operating systems may require additional steps, as noted below. 

We recommend installing the Joulescope software on the native operating system, not under a virtual 

machine, due to Joulescope’s demanding USB communication requirements. 

8.1.1. Linux 
Many Linux systems, including Ubuntu, use “udev” to manage devices and grant permissions.  You will 

need to install a udev rule that grants Joulescope hardware access to your account.  Download and 

follow the instructions in this file: 

https://raw.githubusercontent.com/jetperch/pyjoulescope/main/99-joulescope.rules 

8.1.2. Windows 
Windows 10 and Windows 11 machines should install and run without any additional steps. 

8.1.3. macOS 
The macOS distribution is currently signed, but it is not distributed through the Apple Store.  macOS may 

indicate security warnings upon installation.  If you receive a security warning, control-click the 

Joulescope application, then select “open” to bypass these security warnings.  You will need to repeat 

the control-click, “open” process several times (usually twice) until macOS finally allows the Joulescope 

software to launch.  After granting this permission once, subsequent runs will start normally. 

8.2. Multimeter view 
Upon first launching the Joulescope user interface host software, you see the multimeter view: 

http://www.joulescope.com/download/
https://download.joulescope.com/joulescope_install/index.html
https://raw.githubusercontent.com/jetperch/pyjoulescope/main/99-joulescope.rules
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You can return to this view at any time using View → Multimeter. 

The multimeter view provides the present operating state at a glance.  The multimeter view displays 

several quantities: 

• Electrical current in amperes (A) 

• Electrical voltage in volts (V) 

• Power in watts (W) 

• Energy in joules (J) 

• Charge in either coulombs I or amp-hours (Ah). 

This display, along with all other value displays in the Joulescope software, the SI standard prefixes for 

orders of magnitude: 

Prefix Power Name 

G 109 giga- 

M 106 mega- 

k 103 kilo- 

m 10-3 milli- 

µ 10-6 micro- 

n 10-9 nano- 

p 10-12 pico- 

 

The multimeter view updates every half second (0.5 seconds) by default.  The software computes and 

displays the statistics over each half-second time window.  The large numbers are the mean (also called 

average) value of that quantity over the window.  The software also displays: 

• σ: The standard deviation 

• min: The minimum value 

• max: The maximum value 
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• p2p: The peak-to-peak value, which is equal to (max – min) 

Note that energy does not display these additional statistics since they are not meaningful.   

Every update represents only the data recorded over the last half-second.  If you click on the 

“Accumulate” button to activate it, then the software extends the statistics to combine each new half-

second window without discarding results from previous windows.   

8.3. Oscilloscope view 
The software includes an oscilloscope view.  Click View → Oscilloscope. 

 

The first view allows you to control the connected Joulescope.  Press  to pause or resume capturing 

live data.  Press  to start and stop recording data to a file.  This feature is only available when the 

device is capturing live data. 

Current Range allows you to select Joulescope’s active shunt resistor.  Most applications use auto, 

where Joulescope automatically selects the best range.  However, you can manually force the range.  

Select off to disconnect power to the target device. 

Voltage Range allows you to select the voltage range.  Joulescope includes a 15V range and a more 

sensitive 2V range.  Most measurements can use the auto setting, which allows the JS220 to determine 

the best range. 

The Control widget in the Oscilloscope view also displays the energy or current consumed.  Left-click or 

select Tools → Clear Accumulators to reset the accumulators to zero.  Right-click or use File → 

Preferences → Units → Accumulator to set the displayed field to either energy or current. 

The software displays two different waveforms by default.  The top waveform is electrical current, and 

the bottom waveform is electrical voltage.  The x-axis is time.  If you have a Joulescope connected, it will 
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automatically add the most recent data to the right of the waveform and shift existing data to the left.  

The y-axis data is the value measured at the corresponding point in time.  Joulescope captures data 2 

million times per second.  When zoomed out, each x-axis pixel may represent many, many samples, 

which are that pixel’s sample window. The plot displays the statistics over each pixel.  The yellow line is 

the mean (average).  The red lines are the minimum and maximum.  Power glitches, such as interrupt 

service routines, are very interesting for energy optimization.  The minimum and maximum ensure that 

you do not miss these events, even when zoomed out.  When you eventually zoom in far enough, the 

red lines disappear because 1 pixel becomes 1 sample, and the minimum and the maximum are the 

same as the average.  You can use File → Preferences → Waveform → show_min_max to disable these 

lines or display the minimum to maximum region as a fill instead.   

The software computes statistics quantities over the full-time window shown in the present view for 

each waveform.  The software displays the statistics on the right edge of the window.  The statistical 

quantities are: 

• µ: The mean (also called average) value 

• σ: The standard deviation 

• p2p: The peak-to-peak value (max – min) 

• min: The minimum value 

• max: The maximum value 

• ∫: The integral over the time window  

The waveform view supports Annotations to present additional information, which includes: 

• A Single Marker that display information at a single point.  Names used by other equipment for 

this feature include marker and cursor. 

• Dual Markers that display information over a time window.  Names used by other equipment 

for this feature include cursors, timing markers, window, and range selection. 

To display statistics at a single point, move the mouse to the x-axis time labels near the top.  Then right-

click (control-click on Mac OS) to bring up the context menu.  Select Annotations → Single Marker. 

 

Left-click the marker to move it with the mouse.  As you move the mouse over the waveforms, the 

vertical marker follows along.  The line displays statistics about that location: 

• t: The sample time for the displayed sample or window 

• µ: The mean (also called average) value 

When the location contains more than one sample per displayed pixel, the line displays statistics over 

that single pixel’s sample window: 
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• σ: The standard deviation 

• p2p: The peak-to-peak value (max – min) 

• min: The minimum value 

• max: The maximum value 

Left-click again to keep the marker in position. 

To display statistics over a selectable range, right-click on the x-axis time labels and select Annotations 

→ Dual Markers.  Left-click a marker to move it with the mouse, then left-click again to stop moving the 

marker.  Hold the Ctrl key while left-clicking to move both markers together.  Right-click (control-click on 

Mac OS) on one of the dual markers to export data or perform analysis over the selected range. 

 

Use the scroll wheel to zoom in and zoom out.  The zoom operation keeps the point under the mouse 

cursor at the same location after the zoom operation.  However, when you reach the maximum extents 

while zooming out, that point may move.  When viewing live data, the zoom operation always keeps the 

most recent data in view at the right. 

Press the left mouse button and drag the cursor left or right to pan in time.  Pan is not supported when 

viewing live data from a Joulescope. 

The software displays the waveform on a linear scale with automatic y-axis ranging by default.  The y-

axis context menu has additional options.  Right-click (control-click on Mac OS) on the y-axis to display 

the menu. 
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When manual ranging is activated, hover over the y-axis and use the scroll wheel to zoom in and out.  

Left-click and drag up and down to pan the y-axis. 

Use the y-axis context menu to change the y-axis scale mode.  The y-axis displays in linear coordinates 

by default but also supports a logarithmic scale.  A logarithmic scale is handy to view wide dynamic 

ranges for current and power. 

Use the y-axis context menu to hide the signal.  Click Settings at the top left to display the settings 

menu.  Select Add → [Signal Name] to display a signal not already shown. 

8.4. Energy and Charge 
The Joulescope measures current and voltage two million times per second.  It then multiplies current 

by voltage to compute power.  Joulescope then integrates power over time to compute energy.  It also 

integrates current to compute charge.  Joulescope displays energy in both the Multimeter view and 

Oscilloscope view.  This value starts accumulating when the software starts.  Use Tools → Clear Energy 

to reset it to zero at any time. 

The energy value and charge value provide a simple measurement to observe changes, especially for 

software.  You can baseline the performance of an operation by recording the measured energy or 

charge value.  You can then make changes, repeat the test, and observe the new energy or charge value.  

The oscilloscope view enables you to investigate in further detail. 

8.5. Open-source 
The host software is open source and written in Python 3.8+.  The host software consists of several 

layers: 

Repo name Python package name Description 

pyjoulescope_ui 22oulescope_ui The Joulescope User Interface written in QT/PySide6 

pyjoulescope joulescope The Joulescope Python “driver” with 
pyjoulescope_driver adapter for JS110 applications.  

Joulescope_driver pyjoulescope_driver Native driver with Python bindings supporting JS220 

jls pyjls High performance file storage for Joulescope data 

 

The Joulescope package was designed so that you can script custom Joulescope actions and integrate 

Joulescope into your applications.   

See the GitHub repositories for the latest details. 
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• https://github.com/jetperch/pyjoulescope_ui 

• https://github.com/jetperch/pyjoulescope 

• https://github.com/jetperch/joulescope_driver 

• https://github.com/jetperch/jls 

You can find examples for how to use Joulescope in your Python application at: 

https://github.com/jetperch/pyjoulescope_examples 

Also see the documentation: 

https://joulescope.readthedocs.io/ 

The Joulescope software depends upon other software and libraries.  See CREDITS.html for 

pyjoulescope_ui and pyjoulescope. 

https://github.com/jetperch/pyjoulescope_ui
https://github.com/jetperch/pyjoulescope
https://github.com/jetperch/joulescope_driver
https://github.com/jetperch/jls
https://github.com/jetperch/pyjoulescope_examples
https://joulescope.readthedocs.io/
http://htmlpreview.github.io/?https://github.com/jetperch/pyjoulescope_ui/blob/master/CREDITS.html
http://htmlpreview.github.io/?https://github.com/jetperch/pyjoulescope/blob/master/CREDITS.html
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9. How to Connect Your Joulescope 
The Joulescope JS220 has flexible connections that allow for a wide variety of measurements.  This 

section describes some common test scenarios. 

1. Measure only current (ammeter) 

2. Measure only voltage (voltmeter) 

3. Measure power supply provided 

4. Measure target device consumption 

5. Measure subsystem consumption 

The Joulescope JS220 sensor provides four connections: Voltage +, Voltage -, Current + and Current -.  

Many test setups also include a power source that provides power and a target device under test that 

consumes power.  We will use the following conventions for this section: 

Label Description 
V+ JS220 voltage + connection 
V- JS220 voltage – connection 

I+ JS220 current + connection 
I- JS220 current – connection 
PS+ Power source voltage + connection 
PS- Power source voltage – connection 
T+ Target device under test voltage + connection 
T- Target device under test voltage – connection 

 

The previous-generation Joulescope JS110 had connections IN+, IN-, OUT+, and OUT-.  The following 

table maps JS110 connections to JS220 connections: 

JS110 JS220 
IN+ V+ and I+ 

IN- V- 

OUT+ I- 

OUT- V- 

Note that the JS220 provides more flexibility by separating V+ and I+. 

9.1. Measure only current (ammeter) 
The Joulescope JS220 features independent current and voltage channels.  You can use your Joulescope 

JS220 to measure the current through any wire.  The JS220 will also compute total charge, the integral 

of current. 

The following figure shows a simple current source with a wire.  The current source polarity and arrow 

are for convention only, and current can flow in both directions. 
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Simply insert the JS220 inline: 

 

Since your JS220 can measure current flowing in either positive or negative direction, the current flow 

direction indicator is for convention only.  If connected in the opposite direction, the measurement 

polarity (sign) is reversed.  When connecting your JS220 like this, ensure that the current source does 

not exceed the Joulescope JS220 limit of ±3 A. 

During normal operation, the JS220 is designed to keep the voltage at I+ almost equal to the voltage I-.  

The JS220 uses a resistor to sense the current flowing between I+ and I-, but it limits the shunt resistor 

voltage to 20 mV maximum, at least for all current under 2 A.   

When not connected, you will observe random voltage measurement values that may change over time.  

The JS220 has extremely high input impedance on V+ and V-.  Most test instruments add a known 

resistance, often 1 MΩ or 10 MΩ, that pulls V+ to V-.  The JS220 focuses on low-power measurement, 

and such a resistor would consume meaningful current.  The drawback is that unconnected voltage 

measurements are affected by nearby electromagnetic fields and the input bias currents of the JS220’s 

input stage opamps.  To eliminate fluctuating voltage readings while using the JS220 as an ammeter, 

connect I+ to both V+ and V-. 

9.2. Measure only voltage (voltmeter) 
The Joulescope JS220 features independent current and voltage channels.  You can use your Joulescope 

JS220 as a one channel, high-impedance, isolated oscilloscope.   
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Note the extra connection between V+ and I+.  With the standard binding post front panel, you can 

insert a short length of wire to make this connection.  The V- and V+ signals must remain within ±15 V 

of I+ to measure correctly.  The easiest way to ensure this condition is to connect I+ and V+ as shown.  

Also ensure that the JS220 Current Range is set to anything other than off.  Unlike most test equipment, 

the voltage inputs are completely floating and isolated, so you need to make this connection.  

9.3. Measure power supply provided 
The JS220 can measure the current, voltage, power, charge, and energy provided to a target device 

under test by a power source.  A typical system consists of a power source and a target device under 

test. 

 

The power source can be anything that provides electricity including a battery, battery pack, 

rechargeable battery, bench power supply, mains wall adapter, USB, and power regulators. 
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The target device under test can include product prototypes, custom hardware under development, 

development boards, systems, and subsystems. 

The easiest way to connect your JS220 is as an ammeter measuring current in the + wire and as a 

voltmeter across the power source PS+ and PS-, like this: 
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Note that the V- wire is connected to PS- and T-.  It does not connect to PS+.  This setup configures the 

Joulescope JS220 in high-side current sense configuration.   

If you are familiar with the previous-generation Joulescope JS110, this configuration is the exact same as 

connecting IN+ to PS+, IN- to PS-, OUT+ to T+, and OUT- to T-.  The FP02-BNA front panel provides 

the JS220 with the exact same connections as the JS110. 

The JS220 can alternatively be used to measure current on the low-side wire connected to PS-. 

 

9.4. Measure target device consumption 
The JS220 can measure the current, voltage, power, charge, and energy consumed by a target device.  

The JS220 and wires all have resistance (impedance).  When current flows, this resistance causes a 

voltage drop according to Ohm’s Law: V = I * R.  While this energy is provided by the power source, it is 

consumed by the connections between the power source and the target device under test.  This loss 
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should not be included in the measurement for target consumption.  The JS220 is specifically designed 

to enable more accurate, 4-wire Kelvin-connection measurements: 

 

To minimize noise pickup, you want to minimize the loop area.  The easiest way to do this is twist the 

insulated + and – wires together from PS+ and PS- all the way to T+ and T-, like this 

 

Just before connecting to the T+, connect the JS220, connecting the additional wires to the JS220 I+ 

and I- together.  Finally, twist the insulated V+ and V- wires together. 

Shorter wires result in both lower resistive voltage losses and lower noise pickup.  However, for 

applications where the target device contains an RF transmitter, you do not want the cables too short.  

You want to ensure that the JS220 does not become part of the antenna.  A good rule of thumb is that 

you should locate all test equipment one wavelength away from the RF transmitter.  One wavelength is 

approximately 33 cm at 915 MHz and 12 cm at 2.4 GHz. 

9.5. Measure subsystem consumption 
The JS220 can measure the current, voltage, power, charge, and energy consumed by subsystem on the 

target device under test.  Many devices and prototype boards have jumpers to simplify current 

measurement in system.  However, some hardware devices require the user to remove a resistor or cut 

a printed circuit board trace to measure the subsystem current consumption.  In either case, you want 

to connect the JS220 as an ammeter inline with the power source to the subsystem to measure current.  

The JS220 will also compute charge, the integral of current.   
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For voltage, power, and energy, also connect the JS220 voltmeter: 

 

This connection recommendation shows a Kelvin-style 4-wire connection, which helps improve accuracy 

and minimize noise pickup.  Connect the JS220 using two wire pairs, one to measure current and one to 

measure voltage.  Twist the insulated V+ and V- wires together and the I+ and I- wires together to 

further reduce noise pickup.  For less accuracy and perhaps a quicker setup time, connect V+ to I+ and 

V- to PS-. 
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10. Theory of operation 
Joulescope simultaneously measures current and voltage, and then computes power and energy.  

Joulescope combines a voltmeter and a fast auto-range current shunt ammeter.   

 

10.1. Ammeter 
The shunt ammeter consists of six (6) current ranges with six (6) different shunt resistor values ranging 

from 0.01 Ω to 1111 Ω.  Joulescope actively selects the best shunt resistor to keep the maximum voltage 

across the shunt resistor to 20 mV.  This low voltage drop minimizes the impact on the device under 

test.  Other equipment, including standard multimeters, have a much larger burden voltage that can 

cause the target device to behave unusually. 

The Joulescope amplifies the voltage across the shunt resistor and then uses an analog-to-digital 

converter (ADC) to digitize the value.  The ADC digitizes the value 2 million times per second to create 2 

million samples per second (SPS).  The Joulescope instrument sends these ADC values to the host 

software over USB.  Given a known resistor value and the measured voltage, the Joulescope uses Ohm’s 

Law to compute current.  Each Joulescope contains a calibration.  The software applies the calibration to 

convert the ADCs into measured current values.  Joulescopes are individually calibrated and tested in 

the factory to ensure that every Joulescope performs to specification. 

As the current changes, the ammeter selects the optimal shunt resistor value.  Joulescope uses 

dedicated hardware to quickly select the appropriate shunt resistor to avoid impacting the device under 

test.  The shunt value selection uses the ADC output, dedicated over-range analog hardware, and a 
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unique algorithm that runs in an FPGA.  The FPGA selects the active shunt resistors using MOSFETs, 

which were carefully qualified to meet Joulescope’s demanding performance characteristics. 

The shunt resistor selection does take some time.  How fast does the shunt resistor need to change to 

have a minimal impact?  The linearized equation is: 

t = C * ΔV / ΔI   

Let’s take a typical example. The target device takes 3.3V and can tolerate a temporary 3% (0.03) 

voltage glitch on a 1 amp change.  If the target device has 10 μF of capacitance, the required shunt 

resistor switching time is approximately: 

10 μF * 3.3 V * 0.03 / 1 A = 1 μs   

Joulescope was designed to achieve 1 µs switching speed to meet this demanding case.  Most target 

systems have larger capacitance and less dramatic step current changes.  In all cases, the shunt resistor 

selection is always make-before-break to ensure uninterrupted connectivity to the target device.   

10.2. Voltmeter 
The voltmeter measures the voltage between Voltage + and Voltage -.  The voltmeter scales the input 

voltage, and uses an analog-to-digital converter (ADC) to digitize the value.  The Joulescope instrument 

sends the voltage samples, along with the current samples, to the host computer.  The software applies 

the calibration to convert from ADC values to actual voltage. 

The voltmeter has two different ranges, and you can manually select the best range for your application.  

The 2V range provides higher resolution for smaller voltages, while the 15V range allows for larger 

voltage measurements. 

10.3. Host Computer 
The Joulescope instrument requires a host computer to operate.  The Joulescope instrument sends 2 

million current and voltage samples per second immediately to the host computer over USB.  Unlike 

traditional oscilloscopes, a Joulescope is always capturing data.  The terms “trigger” and “sample buffer” 

do not fully apply to the Joulescope device, since all sample data arrives at the host computer.  The 

Joulescope User Interface (UI) temporarily stores capture data in a circular buffer.  The UI allows you to 

adjust the buffer size to use your host computer’s RAM.  Joulescope can also record to a file, and the 

capture size is only limited by your computer’s available storage on your hard disk drive or solid-state 

drive. 

The Joulescope host software Is open-source.  The pyjoulescope “driver” communicates with the 

appropriate operating system USB driver.  Joulescopes use Microsoft’s WinUSB on Windows, which is 

included by default with the Windows operating system.  On Linux and macOS, Joulescope uses the 

popular, open-source libusb driver.  The pyjoulescope driver provides an easy-to-use scripting 

environment.  You can also use the driver to build integrated applications, such as the Joulescope UI, 

that use the Joulescope instrument data. 

10.4. Power, Energy, Charge, and Statistics 
Joulescopes only measure current and voltage.  The Joulescope software uses math to compute the 

power, energy, and charge.  Power is the current multiplied by the voltage: 
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P   =   V * I   =   V2 / R   =   I2 * R 

 

Energy is the integral of power over time.   

E  = ∫𝑃 𝑑𝑡 

When we talk about energy, we often mean the energy consumed over a specific time interval, which is 

the definite integral: 

E  =  ∫ 𝑃 𝑑𝑡
𝑇

𝑡=0

   ≈     ∑𝑃𝑛 𝛥𝑡

𝑁

𝑛=0

 

The Joulescope host software performs the discrete-time Euler integration shown to the right.  The 

Joulescope software carefully manages the numerical precision to ensure that it computes energy 

correctly.  IEEE double-precision floating-point numbers do not provide sufficient precision. 

Charge is the integral of current over time.   

C  =  ∫ 𝐼 𝑑𝑡
𝑇

𝑡=0

   ≈     ∑𝐼𝑛 𝛥𝑡

𝑁

𝑛=0

 

Charge and energy are mathematically similar.  Both voltage and current contribute to energy, but only 

current contributes to charge. 

10.5. High impedance / low leakage 
Joulescope measures currents at nanoamp resolutions and accuracies.  Many contemporary devices 

have input impedances of 1 MΩ to 10 MΩ, which is not good enough.  At 3.3V, a 10 MΩ load draws: 

3.3V / 10 MΩ  = 330 nA 

Joulescope features a combined input impedance and leakage current of approximately 1 GΩ.  This high 

input impedance allows Joulescope to make accurate and precise low current measurements. 

10.6. Electrical isolation 
The sensor side of Joulescope is electrically isolated from the host computer.  This isolation allows you 

to insert Joulescope into your test system without worrying about ground issues, including ground loops 

and ground noise.   
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11. How to swap the front panel 
Joulescope comes standard with a banana jack front panel.  However, Joulescope is designed to be 

flexible and can support other connector types. 

 

The front panel design is open source, and available on GitHub: 

 https://github.com/jetperch/js220_end_panels 

To swap the front panel, you will need: 

• 2 mm Allen wrench (included) 

• The new front panel 

Swapping the panel is easy, but you do need to take proper precautions to avoid damaging your 

Joulescope.  The JS220 can be damaged by static electricity that you don’t even notice.  When you 

expose the Joulescope main board, be sure only to handle it by the board edges.  Follow these steps 

carefully: 

• Completely disconnect the Joulescope, including Current, Voltage, GPIO, Trigger, and USB ports. 

• Use the Allen wrench to remove the two screws at the sides of the existing front panel. 

• Gently push the Joulescope JS220’s trigger connector into the Joulescope body.  This action will 

push the front panel out.  Expose about ½” or 1 cm.   

• Grab the sides of the main board in one hand, being careful not to touch any other part of the 

board.   

• Grab the existing front panel by the sides and carefully pull it directly out. 

• Grab the new front panel by the sides, align the pins, and carefully push it in.  Be careful to 

ensure that the light pipe fits into the front panel. 

• Fully seat the front panel in the black plastic bezel.  You may need to gently guide the board to 

ensure that the USB connector, trigger connector, and light pipe fit in the back panel. 

• Use the Allen wrench to install the two screws at the sides of the existing front panel. 

 

https://github.com/jetperch/js220_end_panels
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12. GPI & GPO 
The Joulescope contains four (4) general-purpose inputs (GPI) and two (2) general-purpose outputs 

(GPO) located on the GPIO connector to the left of the host USB connecter.  The JS220 includes a GPIO 

cable harness that can simplify connecting the GPIO to target devices and breadboards.  The BNC Trigger 

connector located to the right of the host USB connector can be configured as either an additional 

general purpose input or output. 

 

The JS220 software can record the input signals and control the output signals.  The input signals allow 

the JS220 to monitor other equipment and your device under test.  The output signals can be used to 

control other equipment or the device under test.   The user interface can display inputs time-

synchronized with current, voltage, and power in the oscilloscope view.   

One intended application for the GPIs is to allow the target microcontroller firmware to identify areas of 

interest.  The microcontroller can toggle bits so that you can easily see the energy consumption in the 

marked time windows.   

The GPIO and Trigger are referenced to USB ground.  Many applications using Joulescope will want 

isolated GPI/GPO for improved performance.  When selecting an isolation solution, consider: 

• Electrical isolation 

• Self-powered target interface with very low power from target device – leakage currents only 

• Variable voltage technology levels with an external reference voltage 

• ESD protection 

• Overvoltage protection (GPO) 

• Short circuit protection (GPO) 

• Very high (GΩ) input impedance (GPI) 

To control the GPIO, add the GPIO Widget by selecting View → GPIO. 

 

The GPIO includes an external Vref signal.  When using the GPIO with your device under test, connect 

Vref to the supply voltage on the device under test.  Using Vref ensures that the input threshold and 
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output voltage match the target system.  Using Vref also ensures that the outputs do not backpower the 

device under test. 

Alternatively, the JS220 can use a internal 3.3V reference voltage.  In both cases, Vref determines the 

output voltage high level.  The input threshold voltage is one half of this voltage.   

Inputs are optional.  Check IN0 to enable the GPI0 input. Check IN1 to enable the GPI1 input.  To display 

either IN0 or IN1, select Settings → Add, then select either in0 or in1. 

 

Manually toggle OUT0 by pressing the OUT0 button.  Manually toggle OUT1 by pressing the OUT1 

button.   

As Joulescope UI 0.10.5 as of 2022-10-16, the Joulescope UI does not support GPI2, GPI3 and trigger.  

These features are currently only supported through the 36oulescope_driver and scripting.  Future 

Joulescope UI releases will make these signals available. 
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13. Electrical Isolation 
The Joulescope is electrically isolated between the USB interface and the IN/OUT sensor.  Joulescope is 

rated to ±48V between USB ground and any of Current +, Current -, Voltage +, and Voltage -.  The 

individual component ratings far exceed this specification.  The components are: 

Part # Mfgr Description Isolation 
working 

Isolation 
60s 

Isolation 
1 s 

750316018 Wurth Transformer 400 VRMS 2500 VAC 3125 VAC 

ISO7762 TI Digital isolator 445 VRMS  4500 VRMS 

TLP2361(TPL,E Toshiba Opto isolator 500 VRMS 3750 VRMS  

 

The printed circuit board (PCB) clearance between the isolated sensor side and the USB host side is 

1 mm.  The use of an aluminum enclosure effectively limits the isolation voltage and requires that USB 

chassis ground surrounds the sensor edges. 



 

Revision 1.3 Joulescope JS220 User’s Guide Page 38 / 51 
 www.joulescope.com 

14. Typical Behavior 
This section contains information regarding typical Joulescope JS220 behavior. 

14.1. Step Response 
Joulescope is a shunt ammeter with incredibly fast autoranging.  This section contains typical 

autoranging measurements. 

The test setup includes a Joulescope JS220 with the JS220 Evaluation Kit 1 (EVK).  For this test, an 

additional 2200 µF electrolytic capacitor was placed across Voltage + and Voltage – to assist the 

transient response of the EVK’s low dropout regulator. 

 

This test shows the current consumption going from 97 nA to 100 mA.  The JS220 responds immediately 

to the change in current.  The very slight ripple before the edge is caused by the low-pass FIR filter on 

the JS220. 
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15. Maintenance 
The Joulescope JS220 is designed for minimal maintenance.  To clean your Joulescope, disconnect all 

wires from the unit.  You can gently wipe the unit with a damp cloth using water only.  Using rubbing 

alcohol or other cleaning agents may damage your Joulescope.  Do not submerge.   

Joulescope is factory calibrated and should continue to function within specifications over its operating 

life.  For critical or demanding applications, you may choose to follow industry-standard practices and 

have your Joulescope recalibrated annually.  Tra-Cal, located in Maryland, USA, provides authorized ISO 

17025:2017 calibration and recalibration.  You can submit your request at: 

https://nscainc.com/calibration-repair-rfq-form/ 

Recalibrating Joulescope requires custom equipment and trained personnel.  Only Jetperch LLC and 

Tra-Cal are authorized to perform recalibration.   

15.1. Verification Procedure 
Calibration should normally find that the Joulescope instrument still operates within specification.  

Although calibration can only be performed by authorized vendors, any facility capable of performing 

precision multimeter calibration can verify that a Joulescope is operating within specification.  This 

section describes the verification procedure. 

15.1.1. Preliminary operations 
1. Download the host computer software from https://www.joulescope.com/pages/downloads 

2. Install the software 

3. Download the validation spreadsheet from 

https://download.joulescope.com/docs/validation/index.html 

4. Connect your Joulescope to the host computer using the provided USB cable.   

5. Select View.  If the first Multimeter is not already selected, select it. 

6. Select View.  If Control is not already selected, select it. 

7. Open the validation worksheet in Excel and fill in the Device Under Test Information. 

8. Select File → Save As for this device calibration. 

9. Optionally configure your Test Uncertainty Ratio (TUR) to your desired level.  We recommend 

following industry-standard practices and set TUR to 4 or greater. 

15.1.2. Voltage Validation Process 
1. Connect calibrator OUT terminals to the Joulescope Voltage terminals, observing polarity. 

2. Connect Voltage + to Current +.  Leave Current – open. 

3. In the Joulescope UI, select Voltage Range to 15V. 

4. Configure the calibrator to the target voltage. 

5. Record the actual calibrator voltage, the calibrator’s uncertainty at that voltage, and the 

Joulescope’s measured voltage as displayed by the Joulescope UI. 

6. Repeat 4 and 5 for each target voltage. 

7. Repeat 2 through 6 for the 2V range. 

The following image shows the calibration spreadsheet: 

https://nscainc.com/calibration-repair-rfq-form/
https://www.joulescope.com/pages/downloads
https://download.joulescope.com/docs/validation/index.html
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During the test process, you should fill in all light-blue cells with measurement data.  All TUR values 

should be green.  Yellow indicates that the test setup lacks sufficient accuracy.  All “As Measured” values 

should be green.  Red indicates that the Joulescope does not meet specifications. 

15.1.3. Current Validation Process 
The current calibration process can be performed using several methods.  In all cases, the goal is to 

generate a current close to the target current.  Strict accuracy on the generated current is not required.  

However, a reference measurement is required.   

The general process is 

1. Select the Current Range in the Joulescope UI. 

2. Configure the target current. 

3. Record the applied current as measured by the reference, reference’s uncertainty at that 

current, and the Joulescope’s measured current as displayed by the Joulescope UI. 

4. Repeat 2 and 3 for each target current 

5. Repeat 1 through 4 for each current range. 

15V Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-14.500 V 0.010 0.0 -0.010 0.010

-12.000 V 0.010 0.0 -0.010 0.010

-9.000 V 0.010 0.0 -0.010 0.010

-6.000 V 0.010 0.0 -0.010 0.010

-3.000 V 0.010 0.0 -0.010 0.010

0.000 V 0.010 0.0 -0.010 0.010

3.000 V 0.010 0.0 -0.010 0.010

6.000 V 0.010 0.0 -0.010 0.010

9.000 V 0.010 0.0 -0.010 0.010

12.000 V 0.010 0.0 -0.010 0.010

14.500 V 0.010 0.0 -0.010 0.010

2V Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-1.950 V 0.002 0.0 -0.002 0.002

-1.500 0.002 0.0 -0.002 0.002

-1.000 V 0.002 0.0 -0.002 0.002

-0.500 0.002 0.0 -0.002 0.002

0.000 V 0.002 0.0 -0.002 0.002

0.500 V 0.002 0.0 -0.002 0.002

1.000 V 0.002 0.0 -0.002 0.002

1.500 V 0.002 0.0 -0.002 0.002

1.950 V 0.002 0.0 -0.002 0.002

Voltage Measurement
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Note that many of the test cases are for a 0.0 amp target current.  In this setup, you can simplify the 

setup and leave the Joulescope instrument disconnected, or optionally short the Joulescope Current 

terminals with a banana jumper wire. 

Numerous valid test equipment methods exist to generate and accurately measure the target current.  

You may select a method that is appropriate for your equipment.  The Joulescope JS220 has a very large 

current range, and you will need to accurately measure from 18 µA to 3 A.  You may need to employ 

more than one method to cover the entire current range with a sufficient TUR.  Possible methods 

include:  

10 A Range
Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty Lower Limit

As 

Measured Upper Limit

-3.00 A 0.00 0.0 0.00 0.00

-2.00 A 0.00 0.0 0.00 0.00

-1.00 A 0.00 0.0 0.00 0.00

-0.50 A 0.00 0.0 0.00 0.00

0.00 A 0.00 0.0 0.00 0.00

0.50 A 0.00 0.0 0.00 0.00

1.00 A 0.00 0.0 0.00 0.00

2.00 A 0.00 0.0 0.00 0.00

3.00 A 0.00 0.0 0.00 0.00

180 mA Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-180.00 mA 0.15 0.0 -0.15 0.15

0.00 mA 0.15 0.0 -0.15 0.15

180.00 mA 0.15 0.0 -0.15 0.15

18 mA Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-18.000 mA 0.015 0.0 -0.015 0.015

0.000 mA 0.015 0.0 -0.015 0.015

18.000 mA 0.015 0.0 -0.015 0.015

1.8 mA Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-1.8000 mA 0.0015 0.0 -0.0015 0.0015

0.0000 mA 0.0015 0.0 -0.0015 0.0015

1.8000 mA 0.0015 0.0 -0.0015 0.0015

180 µA Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-180.00 µA 0.15 0.0 -0.15 0.15

0.00 µA 0.15 0.0 -0.15 0.15

180.00 µA 0.15 0.0 -0.15 0.15

18 µA Range

Target Units Applied

Applied 

Uncertainty

Expected 

Accuracy

Test 

Uncertainty 

Ratio Lower Limit

As 

Measured Upper Limit

-18.000 µA 0.030 0.0 -0.030 0.030

0.000 µA 0.030 0.0 -0.030 0.030

18.000 µA 0.030 0.0 -0.030 0.030

Current Measurement
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Method 1: Reference current source 

If you have a reference current source, connect the current source to the Joulescope Current terminals, 

observing polarity.  

In step (2), directly configure the reference current source to generate the target current. 

In step (3), read the applied current from the reference current source. 

Method 2: Reference ammeter with current source 

Connect an inaccurate current source + terminal to the Joulescope Current + terminal.  Connect the 

Current – terminal to the reference ammeter + terminal.  Connect the reference ammeter – terminal 

back to the current source – terminal.   

In step (2), configure the inaccurate current source to the target current. 

In step (3), read the applied current from the reference ammeter. 

Method 3: Reference ammeter with voltage source and variable load resistor 

Connect an inaccurate voltage source + terminal to the Joulescope Current + terminal.  Connect the 

Joulescope Current – terminal to one terminal of a variable load resistor.  Connect the other variable 

load resistor terminal to the reference ammeter + terminal.  Connect the reference ammeter – terminal 

to the Joulescope inaccurate voltage source – terminal.   

In step (2), select a target voltage and resistance combination to give the target current as computed 

using Ohm’s law: I = V / R.  Configure the load resistance, configure the voltage source, then enable the 

voltage output.  Ensure that the voltage stays between 0 and 15V.  We recommend adding a step 3.5 to 

disable the voltage output before changing the load resistance for the next target current. 

In step (3), read the applied current from the reference ammeter. 
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16. Compliance 
For additional compliance information, see 

https://www.joulescope.com/compliance/js220 

 

16.1. United States 

16.1.1. FCC Compliance Statement 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and (2) this device must accept any interference 

received, including interference that may cause undesired operation. 

16.1.2. FCC Notice 
This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. This equipment generates, uses and can radiate radio 

frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 

interference to radio communications. However, there is no guarantee that interference will not occur 

in a particular installation. If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment off and on, the user is encouraged to try 

to correct the interference by one or more of the following measures:  

• Reorient or relocate the receiving antenna.  

• Increase the separation between the equipment and receiver.  

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications not expressly approved by the party responsible for compliance could void the 

user’s authority to operate the equipment. 

16.2. Canada 
CAN ICES-3 (B)/NMB-3(B) 

16.3. Europe 

 

Jetperch LLC declares that this device complies with the essential requirements and 
other relevant provisions of Directive 2004/108/EC.  

 

 

In accordance with the European Waste Electrical and Electronic Equipment Directive 
(WEEE), this device needs to be recycled in accordance with local regulations.  

 

https://www.joulescope.com/compliance/js220
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16.4. Safety 
Joulescope is an Extra-Low Voltage device as per IEC 60038.  Joulescope is intended for INDOOR USE 

only. 

16.5. RoHS Directive 2011/65/EU, 2015/863/EU 
This product is CE marked and complies with the European Union’s Directive 2011/65/EU OF THE 

EUROPEAN PARLIAMENT AND OF THE COUNCIL of 8 June 2011 on the restriction of the use of certain 

hazardous substances in electrical and electronic equipment. 

EU Directive 2015/863 of 31 March 2015 amends Annex II to Directive 2011/65/EU of the European 

Parliament and of the Council as regards the list of restricted substances. 

16.6. Country of origin 
United States of America 

Assembled in Maryland, USA. 

Contains foreign and domestic components. 
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17. Warranty 
The Joulescope JS220 is warranted to be free from defects in materials and workmanship for a period of 

one year from the date of purchase.  If your Joulescope becomes inoperative from such a defect within 

the warranty period, Jetperch will either repair or replace your unit, at Jetperch’s discretion. 

This warranty covers normal use.  The warranty does not cover damage which occurs during shipment.  

The warranty does not cover damage from improper use, misuse, abuse, tampering, alteration, accident, 

software hacking, or recalibration other than by an authorized recalibration provider. 

Jetperch LLC makes no other representations or warranties, express or implied, of any kind including, 

but not limited to, any implied warranty of merchantability or fitness for a particular purpose.  Jetperch 

shall not be liable for loss of use of Joulescope.  Jetperch will not be liable for any other incidental or 

consequential damages, expenses, or financial losses, nor will Jetperch be liable for claims of such 

damages.   

To submit a warranty claim, contact support@jetperch.com.  You will need to provide your name, 

address, phone number, and email.  You will also need to provide proof of purchase, such as a purchase 

receipt, that contains the original date of sale. 

mailto:support@jetperch.com
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18. Intellectual Property 
This product is protected by the following patents: 

U.S. Patent Number 11,249,117 

Additional U.S. Patents Pending 

Joulescope is a registered US trademark of Jetperch LLC. 
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19. Contact 
To purchase this product, visit: 

https://www.joulescope.com 

To submit a warranty claim, first review the warranty section above.  You can submit warranty claims to: 

support@joulescope.com 

If you have questions regarding operation of Joulescope, search the website at: 

https://www.joulescope.com/  

And visit the forum: 

https://forum.joulescope.com/ 

For compliance information, see 

https://www.joulescope.com/compliance/js220 

If you wish to contact Jetperch regarding the operation of your Joulescope, contact us through email at: 

support@joulescope.com  

 

 

Location 

Jetperch LLC 

3470 Olney – Laytonsville Rd. 

Suite 104 

Olney, MD 20832-1734 

USA 

 

https://www.joulescope.com/
mailto:support@joulescope.com
https://www.joulescope.com/
https://forum.joulescope.com/
https://www.joulescope.com/compliance/js220
mailto:support@joulescope.com
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20. Glossary 
 

Accuracy 

The average variation in the bias between measurements and truth.  Good measurements are both 

accurate and precise. 

Ammeter 

A device that measures electrical current. 

Burden Voltage 

The voltage drop that occurs through the test equipment device.  For shunt ammeters, the burden 

voltage includes the voltage across the shunt resistor, connectors, fuses, and any additional resistance in 

the device. 

Current 

The flow of electric charge per time from positive voltage to negative voltage, measured in amperes (A), 

often called amps.  One amp is one coloumb of charge flowing per second.  One coloumb is 

approximately 6.242 x 1018 electrons, but electric current is defined opposite to the electron flow. 

Energy 

The total power exerted over time, measured in joules (J).  Energy is the time integral of power. 

Insertion Loss 

The loss in signal power due to a device in the signal path, most commonly used in reference to radio 

frequency (RF) or telecommunications.  See Burden Voltage. 

Multimeter 

A multifunction device that usually incorporates a voltmeter and shunt ammeter, at a minimum.  A 

standard multimeter supports only one measurement quantity at a time. 

Ohm’s Law 

The equation that relates voltage, current and resistance: V = I * R 

Oscilloscope 

A device that graphically displays a one or more signals, usually voltages, varying over time as a two-

dimensional plot with time on the x-axis and the signal on the y-axis. 

Power 

The time-rate of doing work, measured in watts (W).  Power is voltage multiplied by current. 

Precision 

The amount of variation between measurements of the same value relative to each other.  Good 

measurements are both accurate and precise. 

Resistance 

The quantity of opposition to the flow of electric current. 

Shunt Ammeter 

An ammeter that measures the voltage across a resistor, and then uses Ohm’s Law to compute current. 
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Shunt Resistor 

The resistor used by “Shunt Ammeters” to detect current using Ohm’s Law:  I = V / R.  Given a known R 

and a measured V, the ammeter computes I. 

Universal Serial Bus (USB) 

The now ubiquitous standard for connecting computers and peripherals.  Joulescope connects to the 

host computer using USB 2.0 high-speed operating at 480 Mbps. 

Voltage 

The electric potential difference, measured in volts (V). 

Voltmeter 

A device that measures electrical voltage. 
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21. User’s guide information 
This section contains information regarding this document.  See the other sections of this document for 

information regarding the Joulescope product. 

21.1. Copyright notice 
© 2019-2022 Jetperch LLC 

All material in this Joulescope JS220 User’s Guide, including the text, images, design, and logos, are 

owned by Jetperch LLC, either through copyright or trademark, unless otherwise indicated.  No part of 

this User’s Guide may be reproduced in any form or by any means without prior written consent from 

Jetperch LLC as governed by the United States and international copyright laws.   

21.2. Publisher 
Jetperch LLC 
3470 Olney – Laytonsville Rd 
Suite 104 
Olney, MD  20832-1734 
USA 

21.3. Warranty 
The Joulescope JS220 User’s Guide is provided AS-IS with no other representations or warranties, 

expressed or implied, of any kind including, but not limited to, any implied warranty of merchantability 

of fitness for a particular purpose.  Jetperch LLC does make reasonable efforts to present accurate and 

reliable information in this Joulescope JS220 User’s Guide. 

The information in this User’s Guide is subject to change.  The most up-to-date version of this User’s 

Guide can be retrieved from http://www.joulescope.com/.    

http://www.joulescope.com/
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21.4. Change log 
Revision Date Description 

1.3 2022 Oct 25 Updated photos with higher quality - no content changes. 

1.2 2022 Oct 22 Fixed low-side measurement example figure. 

1.1 2022 Oct 21 Fixed typos and inconsistences. 
Thank you to Mike Fikes for providing feedback. 

1.0 2022 Oct 16 Edits for clarity. 
Added step response measured using EVK. 
Updated Joulescope UI images. 

0.9 2022 Oct 12 Improved “How to Connect Your Joulescope” section. 
Thank you to Simon Merrett for providing feedback. 

0.8 2022 Oct 11 Added connection diagrams. 
Fixed typos and JS110 references. 
Moved compliance section after maintenance section. 
Added intellectual property section. 
Updated required Python version to 3.8+. 

0.7 2022 Sep 28 Updated for beta units. 

0.5 2022 Sep 12 Initial draft for limited public release. 

 


